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Introduction
PRO-3D 2.0 is an additional kit that extends a stereomicroscope by true 3 dimensional
stereoscopic imaging on 3D monitors and TVs with acquisition of 3D and 2D digital
images.

5



6

Introduction



Installation and System
Configuration

Important

To perform the program installation the administrator's privileges are requested.
If you are not a holder of the administrator account, please contact your PC
supervisor.

1. Installation

1.1. 3D Monitor Installation

The system displays the image on a 3D monitor or TV. The monitor is 2D/3D switchable
and it can be used for 3D imaging as well as for standard 2D use. Connect a 3D monitor
or a 3D TV to graphical output of your computer using HDMI or DisplayPort cable and
connect the mains cable as well.

1.2. Installation of USB Interface Cards

Important

In order to achieve a smooth live 3D preview, two independent USB interface
cards (one for each of the cameras) need to be installed into your desktop computer.
In case of connecting the cameras to the same USB interface card or to the
on-board USB connectors a 3D preview might freeze or be laggy.

Install the USB interface cards delivered with the system as follows:

1. Disconnect the mains cable from your computer.
2. Open the computer, locate two free PCI Express slots, insert the two PCI Express

USB interface cards into them and secure them with the screws.
3. Close the computer and connect the mains cable back to your computer and switch

on the computer.
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4. Install the USB interface cards device drivers from the installation disk supplied with
them.

1.3. Software Installation

Install the PRO-3D 2.0 program as follows:

1. Insert the installation disk it to the optical drive and wait for a home screen to appear.
If the home screen does not show automatically, run, from the installation disk,
autorun.exe program manually. Then start the installation of the program by clicking
the Install PRO-3D 2.0 button at the home screen.

2. Install the program according to the on-screen guidelines. The device drivers of the
cameras and a dongle will install automatically.

1.4. Dongle Connection

The PRO-3D 2.0 program is protected by a USB dongle. Connect a dongle (provided) to
the free USB port of your computer. Installation and commissioning of the dongle device
drivers will take place automatically and the LED in the dongle should start glowing.

1.5. Installation of Two Digital Cameras

1. Mount both cameras to the 2 optical outputs of your stereomicroscope.
2. Using the USB cable and extension cord connect the first camera to the first previously

installed USB interface card and wait until the device drivers will be installed.
3. Using the USB cable and extension cord connect the second camera to the second

previously installed USB interface card and wait until the device drivers will be
installed. Make sure both cameras are not connected to the same USB interface card
or to the on-board USB ports.

Correctly installed camera drivers should appear in Device Manager in Universal Serial
Bus controllers group as follows:
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2. Initial System Configuration
Upon the very first launch of the PRO-3D 2.0 program, three configuration wizards, which
will help you to setup the system, will appear gradually in following order.

Note

The setup process is described for the OLYMPUS® SZX stereomicroscope. For
other stereomicroscopes proceed similarly.

1. Camera Positions Setup - this wizard will help you set the camera positions. Proceed
according to the on-screen instructions.

2. Camera Focus Wizard - this wizard will help you adjust the focus of your microscope
and adjust the focus of both cameras. Proceed according to the on-screen instructions.
Use Exposure Time slider and AutoWB button to adjust the live view from the cameras.
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3. Camera Alignment Wizard - the last wizard will help you align both cameras on your
microscope. Proceed according to the on-screen instructions. Use Exposure Time
slider and Auto WB button to adjust the live view from the cameras.
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Graphical User Interface Description
The PRO-3D 2.0 program consists of two windows:

• Main Window - this window is intended for work with still 3D/2D images.
• Live 3D View window - this window displays 3D/2D live view, controls both cameras

and captures 3D/2D images.

1. Main Window
Main Window is divided into several parts:

• Menu Bar - here all the menu items are located.
• Tool Bar - here all the control elements are located.
• Display Window - displays and saves 3D/2D images. The Display Window is able to

handle only one 3D/2D image at the time.

1.1. Menu Bar

File

The File menu contains the following functions: Open... – opens 3D/2D images. The
program is able to open 3D images in proprietary JPS (*.jps) format and 2D images in
JPEG (*.jpg) format. [Ctrl+O] shortcut or drag-and-drop function can also be used to open
images. Save as... – saves 3D/2D images. [Ctrl+S] shortcut can be used to activate this
function. Close Current Image - closes the image opened in Display Window. Exit -
terminates the program. [Ctrl+X] shortcut can also be used to terminate the program.

View

The View menu contains following items: Live 3D View - opens the window with the live
view from the cameras. Full Screen Mode - displays the image opened in the Display
Window in full screen mode. [F] shortcut or double-click to the opened image can be used
to switch this function on/off. Use this function to view the image in 3D. Display Sample
3D Image - opens a sample 3D image.
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Settings

The Settings menu contains the following items: Language - sets the language of user
interface, Open Camera Positions Setup... runs the Camera Positions Setup Wizard, Open
Camera FocusWizard... runs theCamera FocusWizard,Open Camera AlignmentWizard...
runs theCamera Alignment Wizard and Run theWhole Setup Process... runs all the wizards
gradually.

Help

The Help menu contains the following items: Help - opens the electronic user guide, [F1]
shortcut can also be used and About... - displays information about PRO-3D 2.0 program.

1.2. Tool Bar

Open...: opens the 3D/2D image from available disk drivers. [Ctrl+O]
shortcut can be used to activate this function. The image can also be opened
using the drag-and-drop function.
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Save as...: saves currently opened image to available disk drivers. [Ctrl+S]
shortcut can be used to activate this function.

Live 3D View: activates window with live 3D view. [L] shortcut can
be used to activate this function.

Full Screen Mode: displays the image opened in the Display
Window in full screen mode. [F] shortcut or double-click to the
opened image can be used to switch this function on/off. Use this
function to view the image in 3D.

Close Current Image: closes the current image opened inDisplay
Window.

DisplayMode: there are two display modes available: 3D mode
to view the 3D images and 2D mode for display of 2D images.

3D Effect Adjustment: drag
the slider to adjust the level

of 3D effect. The mouse wheel can also be used to control this function. Press right mouse
button to restore the default value.

1.3. Display Window

The Display Window displays and saves captured and opened 3D/2D images.

2. Live 3D View Window
Live 3D View window displays live view from cameras and captures 3D/2D images. The
window consists of a live view and two tabs with control elements.
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2.1. Image Tab

This tab contains following control elements:

Capture: captures 3D/2D image according to current display mode and
transfers it to theDisplayWindow. There can also be used the [Ctrl+Enter]
or [Space Bar] shortcuts. The image will be acquired according to the
live view settings.

Full ScreenMode: displays the live view in full screen mode. [F] shortcut
or double-click to the live view can also be used to switch this function
on/off. Use this function to observe the 3D live view in 3D.

Auto WB: use this function to adjust the color representation of the live
view. This function works best on white background. [W] shortcut can
be used to activate this function.

Exposure Time: click on the arrow buttons
or drag the slider to set the exposure time. The
[+] and [-] shortcuts on the numeric keypad
or the [Page Up] and [Page Down] shortcuts

can be also used to adjust the exposure time.

3D Effect Adjustment: click on
the arrow buttons or drag the slider
to adjust the level of 3D effect.
The mouse wheel can also be used
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to control this function. Press Default button or right mouse button to restore the default
value.

Display Mode: use this selector to display live view in 3D
mode or select which camera should be used for 2D imaging.

2.2. Advanced Camera Controls Tab

This tab contains following control elements:

Image Settings:

• Gain: the slider controls the signal level coming from the camera. Noise can appear
when higher gain values are set.

• Brightness: the slider controls the brightness of the live view.

• Contrast: the slider controls the contrast of the live view.

• Black Level: the slider controls the black level of the live view.

• Gamma: the slider adjusts the gamma correction of the live view.
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ManualWhite Balance: using the sliders the live view color
representation can be manually adjusted.

Edge Enhancement: this function enhances edges in the live view.

Frame Rate: this indicator displays the current frame rate of both
cameras in Frames Per Second.
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How to Use the PRO-3D 2.0
1. Live 3D View Observation

In order to observe the live view from a microscope in 3D proceed as follows:

1. Open the Live 3D View window.

2. Pull out the optical path switch of a microscope so that the image will be visible by
both cameras.

3. Make sure the Display Mode is set to 3D Mode.

4. Adjust the white balance using the Auto WB button or by Manual White Balance
sliders at Advanced Camera Controls tab.

5. Place a specimen under the microscope and set the illuminator to high intensity.

6. Adjust the exposure time using the Exposure Time slider or by [+] and [-] or [Page
Up] and [Page Down] shortcuts.

7. Switch the live view to full screen mode by Full Screen Mode button or by
double-clicking to the live view.

8. Switch the 3D monitor to 3D mode and select the side-by-side 3D mode.

9. Put on the 3D glasses and adjust the 3D effect using the mouse wheel to achieve the
best 3D impression. To restore the default 3D effect level use the right mouse button.

Note

In case the 3D effect is inverted switch the side-by-side 3D mode of your monitor
from L/R to R/L
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2. Capturing Images
To capture an image press the Capture button or use the [Ctrl+Enter] or [Space Bar]
shortcuts. The image will be immediately transferred to the PC and displayed in theDisplay
Window. The Live 3D View window will automatically minimize to the system task bar
where it is ready for further capturing. The image will be captured in the mode selected
by the Display Mode selector. That means a 3D image will be captured when 3D Mode is
selected and 2D image will be captured when one of the 2D - Left Camera or 2D - Right
Camera modes is selected.

Important

The program works only with a single captured image in Display Window at the
time. When next image is captured the previously captured image is replaced in
Display Window by the new one. In order not to loose the acquired images save
them immediately after acquisition.

3. Saving Images
In order to save the captured image switch the 3D monitor back to 2D mode and use the
Save As... function from the Menu Bar or Tool Bar or use the [Ctrl+S] shortcut. The 3D
images are stored in proprietary JPS (*.jps) format which contains both images with
additional alignment information. 2D images can be saved as standard JPEG (*.jpg) files.

4. Opening Stored Images
The stored images 3D (*.jps) and 2D (*.jpg) can be opened by the Open... function from
a Menu Bar or Tool Bar, by [Ctrl+O] shortcut or by drag-and-drop function.

5. Observing Captured/Opened Images in 3D
In order to observe captured/opened 3D image in 3D proceed as follows:

1. Make sure the desired image is displayed in Display Window.
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2. The 3D mode should be activated in Display Mode menu in the Tool Bar of Main
Window.

3. Switch the program to full screen mode by Full Screen Mode button or by
double-clicking to the opened image.

4. Switch the 3D monitor to 3D mode and select the side-by-side 3D mode.

5. Put on the 3D glasses and adjust the 3D effect using the mouse wheel to achieve the
best 3D impression. To restore the default 3D effect level use the right mouse button.

Note

In case the 3D effect is inverted switch the side-by-side 3D mode of your monitor
from L/R to R/L
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Appendix
System Requirements

In order to setup the 3D digital microscope the following equipment is needed:

• Stereomicroscope with two (2) optical outputs with adapters for camera connection
(two eyepiece camera adapters can be optionally used), proper illumination

• 3D monitor or TV with Full HD (1920 x 1080) resolution supporting side-by-side 3D
mode: e.g. LG Cinema 3D

• Desktop computer with following minimal parameters:
○ Intel Core i3 processor (i5 is recommended)
○ 2 free PCI Express slots for USB interface cards
○ 2 GB RAM (4 GB or more is recommended)
○ Windows® XP/7/8.1/10 operating system
○ CD/DVD-ROM drive

Contact Information:
PROMICRA, s.r.o

www.promicra.com

E-mail: support@promicra.com

OLYMPUS® is a registered trademark of OLYMPUS Corp.
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